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Note: Any references in the documentation to the Oracle E-Delivery site pertain if your site has 
access. 

Purpose  

This document includes important, late-breaking information about this release of Oracle’s 
Hyperion® Planning – System 9. Review this information thoroughly before installing Planning. 

For information about issues in the following products, see the corresponding Readme: 

• For Hyperion® Shared Services, see the Hyperion Shared Services 9.3.1 Readme. 

• For Oracle’s Hyperion® Business Rules, see the Hyperion Business Rules 9.3.1 Readme. 

• For Oracle’s Hyperion® Smart View for Office, see the Hyperion Smart View 9.3.1 Readme.  

 

Note: Use the Hyperion Planning - System 9 User’s Guide, Hyperion Planning - System 9 
Administrator’s Guide, Hyperion Enterprise Performance Management Architect Administrator’s 
Guide, and Web help systems to learn how to use Planning. For an overview of the new 
functionality in this release, see the Hyperion Planning - System 9 New Features and Hyperion 
Planning – System 9 Using Administrator Features documents. 

Installation Updates 

Before You Begin an Installation 
Hyperion no longer ships or requires Hyperion® License Server™ (or standalone license files) for 
use with Hyperion products.   

To ensure compliance with your license agreement, Hyperion recommends that you implement 
an auditing process. In addition, during product configuration with Oracle’s Hyperion® 
Configuration Utility™, you activate only the features you purchased. After you configure each 
product, you must open the registry.properties file—in <Hyperion_Home>\common\config 
on the server on which you ran Hyperion Configuration Utility—to review and edit the product 
options. You must complete this step to ensure you comply with your license agreement and to 
activate features you are licensed to use. For more information, see “Hyperion License 
Compliance” in Hyperion Installation Start Here. 
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Installing Shared Services 
If you upgrade any Hyperion product to release 9.3.1, you must also upgrade Hyperion Shared 
Services to release 9.3.1. 

Supported Upgrade Paths 
If you are upgrading from an earlier release of Hyperion products, note the following supported 
upgrade paths:  

• 9.2.0.3 to 9.3.1 
 
Note: Upgrading from 9.2 releases earlier than 9.2.0.3 will be supported in an upcoming 
service pack. 

• 9.3.0.x to 9.3.1 

If you are using a release earlier than 9.2.0.3, you must first upgrade to one of the releases 
noted above, and then upgrade to 9.3.1. See the product installation guides for the products 
you are using for upgrade procedures. 

General Installation Issues 

Upgrading Planning 
• You cannot upgrade Planning 4.0.5.2 applications to Planning 9.3.1. To work around this, 

update the version information in the SystemCfg table from 4.2 to 4.3. (8-612712371) 

• To redeploy a Planning application on Oracle 10g application server, complete these steps: 

1. In Oracle Enterprise Manager, stop HyperionPlanning and HTTP server. 

2. Undeploy the Planning application. 

3. Follow the instructions in “Manual Configuration of the Web Environment” in the Hyperion 
Planning – System 9 Installation Guide to re-create the instance and deploy Planning. 

You can use the dcmctl utility provided by Oracle ($Oracle_home/dcm/bin/dcmctl) to 
perform some of these commands outside of Oracle Enterprise Manager. For more 
information, see the documentation provided by Oracle. 

• On HP-UX systems, when using the Hyperion® Home Migration Utility to copy Hyperion 
Home components to a new location, the migration utility sometimes does not remove 
components from the old location. (1-212067873) 

Other Installation Issues 
• In the Hyperion Configuration Utility, you must run the Configure Database task to generate 

the PlanningSystemDB.properties file before selecting Product Instance Registration or 
Data Source Configuration task. (8-505905797, 8-528366881) 

• When reconfiguring Oracle’s Enterprise Performance Management Architect on WebSphere, 
make sure that the ports entered during the "Deploy to Application Server" task are not 
being used by other programs. You can enter a different port if necessary. (8-506610416)  

To resolve a port conflict error while redeploying: 

1. Exit the Hyperion Configuration Utility.  

2. Undeploy Performance Management Architect by executing the batch files 
UndeployEPMAWebTier.bat and UndeployEPMADataSync.bat located in 
%HYPERION_HOME%\deployments\WebSphere6\bin  
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3. Using the Hyperion Configuration Utility, select the "Deploy to Application Server" task 
under Performance Management Architect, and deploy again.  

• When you configure using VNC, terminal services, or remote desktop, an error message 
displays after you click Next in the Hyperion Configuration Utility. To work around this, after 
entering information in the dialog box, wait several seconds before typing Next. (8-
515492551) 

• When you configure multiple products during the same Hyperion Configuration Utility 
session, database information from the previous product is shown when you configure a 
new product and view configuration details. (8-629254051) 

• On an AIX machine, if you have difficulty with migrating an application from an earlier 
release of Planning, check that the PLANNING_HOME system environment variable exists. (8-
531029216) 

• After creating a Data Source Name, you must restart the Planning server. (526722751) 

• On Windows 2003, when you uninstall Planning and reinstall it, you cannot continue the 
installation process after selecting components. To work around this in Windows 2003, after 
uninstalling Planning, rename the vpd file in the user profile directory (for example: 
<drive_letter>:\Documents and Settings\<user>\WINDOWS\vpd where vpd is the 
vpd.properties file). Then reinstall Planning. (1-266654021) 

• If you are deploying to Apache Tomcat on a supported 64-bit platform, the machine hosting 
Tomcat must have a 32-bit JDK installation. (No CR number) 

• In addition to native Hyperion single sign-on, Hyperion products can integrate with 
Netegrity SiteMinder, a Web access management solutions provider. Planning supports 
single sign-on with SiteMinder. To enable Planning to function correctly with SiteMinder, 
ensure that the following conditions are met:  

• The product URL, such as http://<server>:8300/HyperionPlanning/, is protected in 
the SiteMinder Policy Server.  

• Shared Services uses UserMgmtConsole.jsp, Dimensions.jsp, Tasklist.jsp, and 
FormManagement.jsp to communicate with Planning, and all users must have 
unprotected access to the URL.  

For details on unprotecting specific URLs, refer to the SiteMinder Policy Server 
Administration Guide. (No CR number)  

• To avoid performance issues, during installation turn off any screensavers that are running 
on your Planning servers. (No CR number) 

• Due to an InstallShield issue, if you attempt to install Planning on the same computer on 
which PC Anywhere is installed, Java Virtual Machine (JVM) does not get installed. To work 
around this, uninstall PC Anywhere before beginning installation of Planning. The JVM will be 
installed along with the product. After you complete installation of Planning, reinstall PC 
Anywhere. (No CR number) 

• When you uninstall Planning on WebSphere 5.1, Planning is undeployed from WebSphere, 
but port 8300 stays open. (1-124079516) 

Support for Third-Party Products 

This release is the last release to support: 

• WebLogic 8.1.6 

• HP-UX 11i (RISC) 
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Known Issues 

This release of Planning has these known issues. 

Audit Reports 

• An audit report does not show the names of the Calculate Currencies and the Calculate 
Form calc scripts when they are launched. Instead, the ID_1 column in the 
HSP_AUDIT_RECORDS table displays NULL instead of the name of the calc script. (3-
358953) 

Business Rules  

• There is a problem using carriage returns in a business rules sequence. (8-615645305) 

• Running sequences is not supported in a load balanced or clustered environment. (8-
612407307) 

• You might not see the full path to the selected plan type in the Business Rules Associated 
Outline text box if the server name is too long. (8-511906373) 

• Business Rules Saved Selections may not be migrated successfully. (8-512549934) 

• Limits applied to runtime prompt members’ selection are ignored when using substitution 
variables with values outside the limits. (1-141154291). 

• Performance is slow when exporting a group of business rules from Oracle’s Essbase® 

Administration Services™. (8-571157669) 

• You cannot use the Business Rules CmdLnLauncher.exe in Oracle’s Hyperion® Application 
Link to launch a business rule with runtime prompts if the path of the runtime prompts file 
contains spaces. To work around this, include the runtime prompts in a text file instead of a 
runtime prompts file. (8-525196221) 

• When the Business Rules connection to the relational database is lost, Business Rules does 
not reconnect to it. To work around this, restart the Administration Services and Planning 
servers. (8-524978789) 

• If you run a business rule having a runtime prompt that is based on a relationship function 
(for example, @IDESCENDANTS(Europe) that results in a large number of members (for 
example, 5,000 members or more), the business rule can fail if the generated calculation 
script exceeds the Essbase limit of 64K. (8-541764851) 

• If Administration Services is deployed on an Oracle10g application server, imported 
business rules do not display line terminator characters when viewed in the Administration 
Console. This is a display issue only, and does not affect rule functionality. (1-241032582) 

• If you add a user to an existing group, that user does not see in Planning Web the business 
rules to which the group is assigned access. To address this, restart the Planning server or, 
in the Administration Services console, delete and then add back the group from the Access 
Privileges for the business rules. (1-220671756) 

• If you have a sequence with one or more business rules that contain hidden runtime 
prompts, you may not be able to launch the sequence. To work around this, do not hide the 
runtime prompts within the rules themselves; instead, hide the rule’s runtime prompts in 
the Launch Variables tab of the sequence. (CR 1-219225915) 
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• If you use the function @LEVMBRS("Account", 0) in a runtime prompt variable for a rule 
that is designed against a Planning location, you may receive an error message when you 
try to save it, and no members will be available for selection when you launch the rule. To 
work around this, exclude hidden members in the Account dimension that are not visible in 
Planning member selection. For example, use the @Remove function: 
”@Remove(@Levmbrs("Account',0), @Idecendents(HSP_RateType))”    (1-215873351) 

• When large numbers of concurrent users launch business rules, business rule launch errors 
might be displayed on the Planning server. To avoid this, turn off launch logging in the 
HBRServer.properties file. Open HBRServer.properties and comment out the 
HBR.launch_log parameters by adding a # character in front of each line:  

#HBR.launch_log.filename = hbrlaunch.log  

#HBR.launch_log.log_prompt_values = true 

#HBR.launch_log.log_calc_script = false 

#HBR.launch_log.date_format = yyyy/MM/dd:HH:mm:ss.SSS z 

(1-217619111)  

• The Aggregate Data component does not function correctly when more than one Account 
member is selected. For example, you can create a business rule using the component 
Aggregate Data, and then select the Account Members variable in the Account Member 
Selection window. If you then click Validate and select two Account members, the rule is 
not validated and an error displays. (1-130069111) 

• For business rules run on Planning locations, Planning validation is not performed when the 
rule includes the Saved Selections variable. The members are not validated against the 
user’s allowed members. (1-3396318) 

• Older operating systems with older fonts may not support the EURO symbol. In this case, 
the EURO symbol does not display correctly in data forms. To work around this, the 
administrator can manually change the EURO symbol in the relational database to EUR. 
Newer operating systems that support the EURO symbol display it properly in data forms. 
(8-617673510) 

• When a supporting detail line that was added previously is deleted or edited, the Quarter 
Total on the data form does not re-calculate, even though Year Total updates correctly. To 
work around this, you can launch the Calculate Data Form rule and refresh data, or tag the 
summary time period members as dynamic in Essbase. (8-512340901) 

• YearTotal and Period are read-only unless one member for each summary time period 
between YearTotal and the level 0 members is included in the data form definition. (8-
523841924) 

• Newly created data forms do not display in the list of forms until you click the Forms folder 
in the Data Form Folders section. Likewise, if you delete a data form, the forms list is not 
updated to reflect this until you expand the Forms folder. (8-554341180) 

• After you enter or change data, if you close or log off the application without saving your 
data, no message prompts you to save your data, and the new data is lost. To avoid losing 
data, save your data by selecting File > Save or clicking the Save icon. (8-522183082) 

• To prevent subtotals for cells whose Data Type is set to Smart List, Data, or Text, set their 
Aggregation option to Never. (8-552782701) 
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• Business rules that are set to Run on Load or Run on Save in the composite data form 
design are not executed. To work around this, set the business rules to Run on Load or Run 
on Save in one of the original data forms instead of the composite data forms. (8-
539424009) 

• When you select the Hide Dimension option in form design, the rows or columns are not 
hidden in data forms accessed from Planning or Smart View. (8-530537177) 

• After you create a data form, the data form is not listed on the Data Form Management 
page until you first select some other page (for example, Task Lists) and then return to the 
Data Form Management page. (8-535136302) 

• Occasionally when you edit a data form having an asymmetrical design, the column 
dimensions disappear or are ordered incorrectly. (8-509921986) 

• If you change a column (for example, add members) and then change the order of the 
columns without saving between steps, the last two columns are merged into one. (8-
526923428) 

• Sometimes a data form having an asymmetrical design incorrectly generates the Calculate 
Currency calc script. (8-524914867) 

• Access permissions are not enforced at the folder level, allowing interactive users to delete 
other people’s folders. (8-521452390) 

Exchange Rate Tables 

• When using Fill Year or Fill Table, you cannot save a value that has more than 7 digits, for 
example, 1234.5678. (8-529658693) 

External Authentication 

• Users cannot log on to applications if the group’s URL is not specified across all providers in 
the css.xml file. (8-509074785) 

• When using the ExportSecurity utility, users and group names cannot contain characters 
that are used as delimiters, such as commas. (8-623818742) 

• There is a sync issue if a user is provisioned indirectly and the group is moved within OUs. 
To work around this, restart the application server before logging on to Planning. After that, 
the user can log on to Planning as an indirectly provisioned user. (8-611870741) 

• The Shared Services Update Users utility does not work for certain changes to groups. For 
example, when you log in as a user indirectly provisioned through a group and the Groups 
tree has changed, you do not have the correct access permissions. (8-549300637) 

• If you need to change your user directory settings in the CSS.XML file and are also 
upgrading from an earlier release of Planning, you must perform these steps in the following 
order (or else users cannot log on to Planning): 

If you are upgrading from a release earlier than Planning 4.1.1: 

1. Upgrade to Planning 9.3.0.1, following the instructions in the Hyperion Planning – 
System 9 Installation Guide. 

2. Log on to Planning, and click the displayed button, Migrate Users and Groups.  

3. In Shared Services, change your user directory settings. 

4. Run the UpdateNativeDir utility, which you can get from Hyperion Technical Support. 
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5. Run the Planning utility, UpdateUsers.cmd. 

If you are upgrading from Planning 4.1.1 or later: 

1. Upgrade to Planning 9.3.0.1, following the instructions in the Hyperion Planning – 
System 9 Installation Guide. 

2. In Shared Services, change your user directory settings. 

3. Run the Shared Services utility, UpdateNativeDir. 

4. Run the Planning utility, UpdateUsers.cmd. 

For the 9.3.1 release, UpdateUsers.cmd is installed with Planning, and UpdateNativeDir is 
available by request. (No CR number) 

• When you indirectly provision for NTLM, LDAP, or MSAD, users are not added unless the 
provider is first in the search order among similar providers. For example, if multiple LDAP 
providers are defined in the CSS.XML file, indirect provisioning only works for the first LDAP 
provider in the search order. (1-231716451, 1-291108451, 1-249372251, 8-516249064) 

• You cannot add users or groups to Essbase if their names contain a backslash ( \ ). (1-
250552631) 

• With the ImportSecurity utility, you cannot import security access for users who have 
double quote (“”) characters in their names. (1-257126668) 

• If MSAD or LDAP users or groups are renamed in Planning, they are deleted from Planning 
during bulk synchronization. (1-231995871)  

• Single-user synchronization fails if Planning is installed on UNIX and NTLM is used. (1-
150924632) 

• If any providers specified in the Search order section of the CSS.XML authentication file are 
invalid, you are unable to synchronize users and groups from Hyperion® Shared Services 
User Management Console into Planning. When you try to synchronize users and groups, 
this message displays: “The directory service is not detected, so it cannot synchronize 
users. Establish the connection to the directory service, and then perform the 
synchronization.” (1-208327917) 

• Users provisioned indirectly and retrieved using Hyperion® Remote Authentication Module 
are not added to Planning during bulk synchronization. Users can be added to Planning if 
they are provisioned directly. (1-2229617277) 

• When using the ProvisionUsers utility, ignore the FileNotFoundException messages in 
the UserProvisionSync.log file, such as this example: java.io.FileNotFoundException: 
C:\Hyperion\Planning\config\security.properties (The system cannot find the 
path specified). (1-230920874) 

• Hyperion® Remote Authentication Module 9.0.x does not support SSL connections on AIX. 
(No CR number)  

•   In WebLogic, if you set com.hyperion.css.isWebLogic to True, communication is broken 
with the LDAP provider if it does not use SSL. This is because the CSS.XML file tries to 
communicate with the LDAP server over SSL, regardless of the <authProtocol> setting in 
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CSS.XML. If the LDAP provider does not use SSL, do not set com.hyperion.css.is 
WebLogic to True. (3-380274) 

Hyperion Application Link 

• Application Link is not available to new customers for purchase. It is supported for 
customers who purchased it previously and are already using it. (no CR number)  

Hyperion Configuration Utility 

• Using Hyperion Configuration Utility to re-deploy an existing Web application to WebLogic 
8.1.x does not work properly. A workaround is to first un-deploy the Web application using 
the application server admin console, and then use Hyperion Configuration Utility to deploy 
the Web application fresh. (no CR number) 

• When you configure multiple products during the same Hyperion Configuration Utility 
session, database information from the previous product is shown when you configure a 
new product and view configuration details. To work around this, you can start a new 
session of the Hyperion Configuration Utility, or click the Back button, and then click the 
Next button again. (8-629254051) 

• If you use the Hyperion Configuration Utility to configure a different application server, 
users cannot log on to Planning applications through Oracle’s Hyperion® Workspace. This 
can occur, for example, if you use the Hyperion Configuration Utility to configure Planning to 
run with Workspace on WebLogic, then later configure the products to run on WebSphere. 
(8-627629201) 

To work around this, update the httpd.conf file to remove the Include statements for 
application servers you are no longer using. For example, if you configured WebLogic, and 
then changed to WebSphere, update the httpd.conf file to remove the WebLogic entry: 

Include conf/HYSL-WebLogic.conf 

After updating the file, save httpd.conf and restart the HTTP Web server. 

• When you run Hyperion Configuration Utility after upgrading Planning from a release earlier 
than 9.2, the product selection page may display multiple listings for Planning or may not 
list Planning at all. If this problem occurs, perform these steps: 

1.   Navigate to this directory: 
 
Windows: <HYPERION_HOME>\common\config\product\<product>\<release number> 
UNIX: <HYPERION_HOME>/common/config/product/<product>/<release number> 
 
where <HYPERION_HOME> is the Hyperion Home location on the machine and  
<product> is the product name or abbreviation. For example: 
 
Windows: C:\hyperion\common\config\product\planning\4.1.1 

 UNIX: /vol1/hyperion/common/config/product/planning/4.1.1 

2.   Delete the oldest *.xml file from this directory. 
For example, if the directory contains two files named planning_1.xml and 
planning_2.xml, delete the older file. 

3.  Re-run Hyperion Configuration Utility.  

(No CR number) 
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• On UNIX platforms, Application Server Deployment or Web Server Configuration tasks may 
fail if the temporary folder (as defined by the TEMP environment variable) contains *-
build.xml files created by another user. Ensure that *-build.xml files do not exist in the 
temporary folder before running Hyperion Configuration Utility. (1-246275191) 

Logging On 

• If you log on to Planning with “localhost” as the machine name in the URL, when you select 
Access Control Report in Common Administration Services, “Null” is displayed instead of the 
names of users and groups. (1-145392931) 

• Logging on to a Planning application for a non-native administrator can take a long time if 
the application is in maintenance mode. To avoid this issue, take the application out of 
maintenance mode before logging in. (8-530501711) 

• If you are using Windows 2003 Server Standard Edition and Enhanced Security is enabled in 
your browser, the Logon page does not display correctly. To work around this, add the site 
to the list of trusted sites for your browser. (No CR number) 

Menus 

• When you access an Oracle’s Hyperion® Workspace report using a Planning URL menu item, 
you cannot export the report to Excel or print the report in PDF format. (1-248362733) 

• When you right-click to open a menu in a data form, you must click directly on the 
dimension member name displayed for the row heading. Otherwise, the menu does not 
open. (1-161666741) 

Offline Planning 

• The "Use Excel Formatting" option is not available when connecting to the Planning Data 
Source. (8-518364496) 

• In Oracle’s Hyperion® Smart View for Office, shared members are displayed twice when 
selecting a member for a runtime prompt. This happens only if there are two or more 
shared members. (8-627799889) 

• When users who are non-administrator Windows users try to take a data form offline, the 
Offline Provider becomes non-responsive. To prevent this, assign non-administrator 
Windows users read and write access to the following directories and file: 

Directory: <drive letter>:\hyperion\offline\myanalytics 

Directory: <drive letter>:\hyperion\offline\offlinedata 

File: <drive letter>:\windows\system32\msvcr71.dll 

(8-555277891) 

• A business rule with a runtime prompt does not retain the last member selection for 
arguments if it is running as part of a sequence. (1-217781856) 

• There are performance issues with complex data forms. (8-508176564) 

• The first time users download offline content, formatting disappears. This does not occur for 
subsequent downloads, and it never occurs for administrators. (8-525531472) 
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• When content is taken offline, POV dimensions are sorted alphabetically instead of in outline 
order. (8-525633234) 

• The default launch value for a sequence of business rules is not saved. Users must type the 
launch location each time they launch a sequence of rules offline. (8-527378754) 

• In Offline mode, you cannot save supporting details for cells with data type of Date. (8-
503997679) 

• When a POV with no data is selected, a blank data form is displayed. There is no error 
message about suppressed data. (8-525531292) 

Performance Management Architect 

• For optimal performance when using Data Synchronization, use filters. (8-628401631) 

• When using Performance Management Architect to create import profiles, you cannot use 
these characters in the Description field: ! @ # $ %. (8-629224601) 

• Unicode databases with long names cannot be deployed to Essbase from Performance 
Management Architect 9.3.1. (8-628481631) 

• Reordering child members is not supported on Oracle’s Hyperion® Financial Management – 
System 9 System Generated dimensions, such as ICP, View, Value, ICP and Alias. If you 
attempt to reorder system generated dimension children members the validation will fail 
upon deployment. (No CR number) 

• Planning or Financial Management applications containing extended or double-byte 
characters in dimension names may encounter issues when upgrading to 9.3.1 and using 
Performance Management Architect. If your application contains ASCII + 127 or double-
byte characters, please contact Oracle Support for assistance. Applications using Classic 
Administration are not affected. (No CR number) 

• Planning uses the DimensionAlias property for deploying dimensions, including Smart List 
dimensions. When you create a Smart List, you must select System (not Planning) from the 
drop-down list and set the DimensionAlias property to match the DimensionName; 
otherwise, a member’s association to the Smart List is lost during deployment. The 
Performance Management Architect drop-down list for Smart List in the Property grid 
displays the DimensionName for the Smart List dimension, not the DimensionAlias property. 
(8-541932131) 

• Even though a Planning application may have only Plan Type 1 as valid, the other plan types 
are visible on the Property Grid. (8-524909507) 

• Insert Member is not a valid action for the Year dimension even though it is available on the 
right-click menu. (8-506201634) 

• Quotes are not valid on UDA members for Essbase applications. (8-526591932) 

• Even though an end user has been granted Read-Only access permission to a dimension, 
the Property Grid allows the end user to make changes; however, those changes are not 
saved. (8-527712009) 

• If this error is displayed when starting Performance Management Architect services on an 
Oracle database: (8-521313291) 

“Service cannot be started. System.Exception: System.Data.OracleClient requires Oracle 
client software version 8.1.7 or greater."   
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The administrator should adjust the file permissions in the Oracle client install directory.  
Additional information can be found on this Web site: 
http://dotnetjunkies.com/WebLog/rtgurskevik/archive/2005/01/19/45958.aspx 

• When creating an import profile, if the screen is not maximized, the drop-down list on the 
Map Properties screen is not visible. (8-506835953) 

• When an existing interface table data source is edited, and the administrator selects Yes to 
"Existing tables will be deleted”, the dialog box should indicate which tables will be deleted. 
(8-534819278) 

• Hyperion recommends against using the Performance Management Architect shortcut to 
stop the Performance Management Architect services. The administrator should stop all 
services through the Windows Services interface. (8-525486721) 

• Hyperion recommends that administrators not delete an active job from the Job Console. In 
the case of a deployment, the deployment is halted, but the administrator cannot re-deploy 
the Application View until the timeout is exceeded. Eight hours is the timeout default, but 
this can be changed in the AwbConfig.properties setting:  

# App Deployment timeout  
DEPLOY_PENDING_TIMEOUT_MINUTES=4 

(No CR number) 

• If you are using Windows Server 2003 Service Pack 1 with Performance Management 
Architect products, your system may experience an abnormal shutdown. To prevent this, 
install the update from Microsoft by going to: http://support.microsoft.com/kb/923996/ 
(No CR number) 

• After migrating Planning applications, you must provision users and groups in the target 
application in Shared Services. See “Managing and Provisioning Users and Groups” in the 
Hyperion Security Administration Guide. (No CR number) 

• When custom and attribute dimensions are excluded from an Application View in the 
Dimension Library, they are not deleted from Planning when the Application View is 
deployed. (No CR number) 

• When performing an Application Upgrade of a Planning application in the Dimension Library, 
shared members are placed at the bottom of the dimension hierarchy. (8-525632896) 

• When you import dimensions using merge (instead of replace), the process creates a shared 
member rather than moving an existing member to the new parent. (No CR number)  

• Shared Members imported into the Dimension Library display a Shared tag next to them, 
but in Member Properties, their data storage type is set to Dynamic Calc. (8-524909594) 

Planning Adapters 

• Oracle’s Hyperion® Data Integration Management Adapter for Planning and Oracle’s 
Hyperion® Application Link Planning Adapter for Planning load information only into Classic 
applications. Load information into Performance Management Architect applications using a 
flat file. (No CR number) 

Planning Administration 

• In the Period dimension, the Add Sibling button is disabled when YearTotal is selected. To 
work around this, select the Period root member, and then click Add Child. (8-631251708)  

• When you click Add to create a UDA for a Scenario member, the UDA is added, but the 
dialog box is blank instead of displaying the newly added UDA. To work around this, first 

http://support.microsoft.com/kb/923996/
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create and save the Scenario member. Then create the UDA by clicking Edit to edit the 
Scenario member. (8-618797485) 

• A new child member inherits the Data Storage property value from its parent. (1-
209878081) 

• If you are using WebLogic with 64-bit JDK, this error displays after you try to create an 
application with the Classic Application Wizard: "java.lang.UnsatisfiedLinkError" To 
work around this, open the setCustomParamsHyperionPlanning.sh file, and add this 
parameter to the JAVA_OPTIONS setting: -d64 (8-623766610) 

• The ‘Use Members on Form” option does not support data forms with user variables on the 
POV. (8-580437912) 

• The Sort Member utility, SortMember.cmd, generates an error. This error may be ignored. 
(8-624672501, 8-624007794) 

• After restarting the application server, it can take over five minutes to open large data 
forms with many sparse members on rows, such as 40,000 members on 40,000 rows. Data 
forms open quickly the second time they are opened. (1-217009923) 

• Calculations are not correct for accounts with Time Balance set to Weighted Actual_Actual 
and Actual_365 with Dynamic Calc or Dynamic Calc and Store set on Q1-Q4 and Year Total. 
Calculations are correct if all summary periods are Store. (8-520476463)  

• Performance is slow when using Grid Spread and pasting multiple values at the same time. 
(8-597758721)  

• By logging on to the Servlet instead of Planning’s Logon.jsp page, planners and interactive 
users can perform tasks that should be reserved for administrators only. (3-281947) 

• When a base scenario or version member is modified, the change is not propagated to the 
shared members. However, when a shared member is selected, such as on a data form, all 
properties except consolidation parameters are derived from the base member. (8-
62925243) 

• To ensure that the Smart View Take Offline Wizard works with Windows Vista Business 
Edition, you must copy the file mscomct2.ocx to the system32 directory and register the file 
in the system registry. (8-632556423)  

For more information, see: http://msdn2.microsoft.com/en-us/vbrun/ms788708.aspx, 
“Tested and Not Shipping In Windows Vista.” 

• If your application contains accounts with Time Balance set to “Weighted Average - 
Actual_Actual” or “Weighted Average – Actual_365”, in Planning, assign the HSP_LeapYear 
UDA to Year members that are leap years (for example, FY08) and assign the HSP_UDF 
UDA to summary time periods (for example, YearTotal, Q1 and so on) before you refresh 
the database. Alternately, you can copy member formulas from the Administration Services 
console outline and save them in Planning. (1-182253551) 

• For this release of Planning, only extended ASCII characters are supported in a UNIX 
environment. (No CR number) 

 

Relational Databases 

• Planning requires CURSOR_SHARING in Oracle to be set to the default setting, “EXACT”. If you 
have performance issues with Planning cube refresh, check this setting to be sure it is set to 
“EXACT”. (No CR number) 

http://msdn2.microsoft.com/en-us/vbrun/ms788708.aspx
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• For Oracle 9i with Windows Server 2000, if the database has a replication partition, a full or 
partial refresh does not complete, and this error message might display: "Restructuring 
database <dbname> step 26 of 27.” To work around this, remove the partition during 
refresh, and add the partition back again after completing the refresh. (1-XUNI1) 

• If you are using DB2 8.1 relational database software and the Hyperion JDBC driver with 
Planning, you might get the error, "Virtual storage or database resource is not available" in 
your Web application server log. (3-378731) 

Try increasing the heap size database parameters to: 

APP_CTL_HEAP 512  
APPLHEAPSZ  4096   

Another alternative is to use the IBM JDBC driver.  

• On Oracle systems, you cannot run a report on blank planning unit annotations from 
Administration > Reporting. (8-510422081) 

• For applications running on Oracle or DB2 relational databases, it is possible to create data 
forms and user groups that have the same name. Hyperion recommends that you do not 
create data forms and groups with the same name. If data forms or groups with same name 
exist in an application, you should rename them so they have unique names before you 
upgrade to the most recent version of Planning. You should also change data form names 
that have the same name in a different case (uppercase versus lowercase) before upgrading 
to Planning on Oracle or DB2. Using unique names can provide better performance with 
data forms on the Web. (3-163900)  

• On Oracle databases, if two users save supporting detail at the same time when clustering 
over several Web application servers, one user may get an error message. If this happens, 
the user should resubmit the supporting detail. If this situation happens often and you do 
not need to run in a cluster for performance reasons, you could use a single server. This 
error can happen only in clustered mode. (3-395487) 

• Setting the maximum SQL connection to 1 in a Planning property causes problems. If you 
set the maximum SQL connection to 1, you cannot start a planning unit, and after you try to 
start a planning unit, you cannot read from SQL any more. (3-371065) 

Shared Services 

• Because users are cached in Shared Services instead of Planning, accessing users may take 
longer than in earlier releases. (8-622185241) 

• When managing Shared Services models and naming applications, you cannot use the 
forward slash (/), backslash (\), or double quotation (“) characters. All other alphanumeric 
and special characters can be used in application names. (8-514151218) 

• Shared Services no longer supports metadata synchronization. To share dimensions 
(hierarchies) with Financial Management and Planning, use the new Performance 
Management Architect functionality. (No CR number)  

• If you provision users, then delete them, then add them again, you cannot successfully run 
Create Database with the Security Filters option selected to update the users in Essbase. (8-
504281701) 

• With Internet Explorer, sometimes the vertical scrollbar is missing in Shared Services when 
you are viewing low-level Planning members. (1-300400784) 
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• If you add a user in Shared Services whose name is 40 characters long and provision the 
user for Planning, when you update the user list in Planning, this message displays: “Sync 
with user provisioning succeeded with errors.”  This error does not occur if the user’s name 
is fewer than 40 characters. (1-286587351, 1-288947391) 

• Registering a Planning application in Shared Services fails when Siteminder is enabled for 
both Planning and Shared Services. (1-150210051) 

• When you register Administration Services and Planning with Shared Services at the same 
time, the HBRServer.properties file is not uploaded to Shared Services. (1-223236261) 

To work around this: 

1. Register Oracle’s Essbase® Administration Services with Shared Services, selecting these 
two options: Relational Storage Configuration and Shared Services Registration. 

Optional: You can select the Application Server Deployment option now or later. 

2. Register Planning with Shared Services.  

• When you select File > Return to Application from within the Shared Services User 
Management Console, you may receive an error message. To return to the Planning 
application, click OK at the message and proceed to use Planning. (1-115905571) 

To prevent the display of this error message when you select Return to Application from 
within the User Management Console: 

1. From the Microsoft Internet Explorer menu bar, select Tools > Internet Options. 

2. Select the Advanced tab. 

3. In the Browsing section, clear the following check box: Display a notification about 
every script error. 

4. Click OK. 

• Check the Hyperion Shared Services Installation Guide and Readme to learn about 
restrictions in naming users. (For example, you cannot use the “@” symbol in user names.) 
Hyperion also recommends that you check the documentation from your user directory to 
determine any other restrictions. (3-373252) 

• You cannot successfully update a provisioned group from the Shared Services User 
Management Console to Planning if a user in the group includes users from a domain that is 
not trusted. (1-125555230) 

• If Shared Services is installed on a different machine from Planning, access might be denied 
for Manage Models menu item. To work around this, click the Refresh button to refresh the 
page. (3-399675) 

Task Lists 

• When a user does not have access to a particular rule in a task list, all the rules the user 
has access to are displayed. (8-583949250) 



Hyperion Workforce Planning Release 9.3.1 Readme 

16 

• When a task list has only one task, and you select Complete for the task in Basic Mode, an 
error message might display. If this occurs, add another task and select Complete again. 
This does not occur when a task list has more than one task. (8-563907295) 

• If you select a task and see the message, "Loading the requested task - this may take a 
moment..." for a long time, select the task list itself (the top-level folder), and then select 
the task again. (8-539094369) 

Web Browsers 

• Planning is compatible with Microsoft Internet Explorer 7 (IE7). (No CR number) 

• When using Firefox 1.5 with the Linux OS, there are some issues with color dithering, and 
text is not centered on buttons. (8-612079821) 

• With the Firefox browser, long submenu labels do not completely display. (1-458726121) 

• With the Firefox browser, you cannot use the toolbar to copy and paste data. When using 
Firefox, use keyboard shortcuts to copy and paste. (8-601788931) 

Web Clients  

• With Planning, if you use the Essbase dynamic time series Y-T-D (year-to-date) or P-T-D 
(period-to-date), you must update the corresponding Planning dimension names. This is 
because two default Planning dimensions, Year and Period, have the same name as 
members used in the dynamic time series. (1-237456354) 

To work around this, modify the names of the Year and Period dimension. For Classic 
applications, rename them in Planning. For Performance Management Architect applications, 
rename these dimensions before loading them from a flat file. You can also use a different 
dynamic time series member than Y-T-D or P-T-D, such as S-T-D  
(season to date). 

• When an Excel workbook is loaded with a Planning or Oracle’s Hyperion® Financial 
Management – System 9 data form, using another Excel worksheet within the same 
workbook for native Excel usage causes Excel to terminate abruptly. (8-634709026)  

• Copy Data does not support attribute members. (1-126165171) 

• With Solaris, when you log on to Planning, you might see an error message about 
connection pooling. (1-171301411) 

To work around this, set the LANG environment variable to the following: 

SOLARIS: LANG=iso_8859_1 
AIX: LANG=en_US.ISO8859-1 
HP-UX: LANG=en_US.ISO-88591 

Note: If the desired language is not English, en_US should be replaced by the desired 
language and country code combinations. For example, if you are using German on HP-UX, 
the correct setting for LANG is: de_DE.ISO-8859-1 

• If a dense dimension member on a row does not exist in Essbase, the data entry page does 
not display properly, but an error message might not be displayed. For example, you can 
create a form with an account on the row, and then select the member and add children to 
the account. If you do not refresh the information, and then open a form, the form does not 
display properly and an error might not be displayed. (3-380847) 
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Workforce Planning 

Workforce Planning Considerations 

• If you are upgrading from an earlier release and the names of your predefined, required 
dimensions (for example, Accounts and Entities) do not match the new application 
dimension names (for example, Account and Entity), you cannot initialize your Oracle’s 
Hyperion® Workforce Planning application. (8-558153011) 

To avoid this problem: 

1. Upgrade your application to this release. 

2. Using Classic application administration, rename the dimensions in Planning. 

3. Optional: If you want to use Performance Management Architect, migrate your 
Planning Application View in Oracle’s Enterprise Performance Management Architect. 

If you do so, you can no longer use Classic application administration with this 
application.  

Known Workforce Planning Issues 
• You cannot access the predefined business rules in Workforce Planning until you set up 

access permissions for them in Administration Services. (1-180925717) 

To set up access to the Workforce Planning business rules: 

1. Make sure the Administration Services server is started. 

2. Log on to Oracle’s Essbase® Administration Services console with the user name and 
password that you provisioned in Hyperion® Shared Services. 

3. Expand Business Rules > Repository View > Rules to view the predefined Workforce 
Planning business rules. 

4. Under Business Rules, expand Administration > Locations. Right-click All Locations 
and click Open. 

5. Click Add Access Privileges, select the business rules for which you want to assign 
access, and click OK.  

6. Select the users and groups to which you want to assign access, and click Save. The 
selected users and groups now have access to the selected business rules. 

If you did not rename the Workforce plan type, you can access these business rules with 
right-click menus in the Workforce Planning predefined data forms. If you renamed the 
Workforce plan type when creating the application, you must do the following to make the 
predefined business rules accessible by right-click menus in the Workforce Planning data 
forms. 

To make the Workforce Planning business rules available by right-clicking: 

1. Select Administration > Manage Menus. 
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2. Select WFPMenu and click Edit. 

3. For each Menu Item whose Type is Business Rule, do the following: 

a. Select the Menu Item and click Edit. 

b. Under Properties, from Plan Type, select the renamed Workforce plan type. 

c. From Business Rules, select the associated business rules.  

d. Click Save. 

e. Repeat steps 2 and 3 for each Menu Item. 

4. Perform steps 2 and 3 for the WFPMenuNewHires menu.  

You can now launch business rules from Oracle’s Hyperion® Workforce Planning data forms by 
right-clicking in data forms. 

Defects Fixed in this Release 

• Essbase filters are removed when Validate Limit is selected during Classic application 
refresh. (8-611299713) 

• You cannot remove a custom member from the Period dimension after it has been 
deployed. (8-610699309) 

• You cannot display aliases for shared members in Planning Web. (8-593960121) 

• Performance is slow when copying and pasting within data forms. (8-584844146) 

• The member alias is removed when you add a member formula. (8-582722899) 

• Users without Essbase "Database Manager" rights should be able to launch business 
rules through the Business Rules Web Launcher. (8-582722233) 

• You cannot connect to the repository for migration when multiple repositories reside on 
the same server. (8-582593083) 

• In Classic application administration, if an incorrect member formula is validated, the 
member formula is lost. (8-578687577) 

• When you copy supporting detail, this error displays: "ORA-01795: maximum number of 
expressions in a list is 1000". (8-576901730) 

• The Launch button is still active after you launch business rules. (8-576901689) 

• The time balance option for skip missing and zeros is not working. (8-576901653) 

• The system changes the value entered when you use a runtime prompt for a real value. 
(8-576901495) 

• Interactive users can delete data form folders that include data forms. (8-576370803) 
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• Data spreads incorrectly when locking cells on Year Total. (8-575407521) 

• Before a Planning refresh, a new Planning user can access any member using the 
Essbase Spreadsheet Add-In. (8-569427445) 

• You cannot save a large member formula for Scenario, although the same formula works 
correctly for Account. (8-557303541) 

• For business rules that take longer than one hour to complete, Oracle’s Hyperion® 
Business Rules resubmits the rules after exactly one hour. (8-528752666) 

• Security access is not deleted if ImportSecurity is run with this argument: 
SL_CLEARALL. (8-523251655) 

• If there are 10 or more rules in a sequence, the index of the sequence is changed to 
incorrect order. (8-512588811) 

• Entering a very high value (for example, 2,600,000,000) into a runtime prompt can 
produce a slightly different value in Essbase. Entered numbers have only 8 digits of 
precision. (1-233588451)  

• When you externalize Oracle’s Hyperion® Essbase® - System 9, you cannot assign access 
to specific calc scripts. (8-511199655) 

• There are issues with running two Oracle’s Hyperion® Planning – System 9 Web sessions 
simultaneously. (3-396598) 

Documentation Updates 

This section provides late-breaking updates to the documentation.  

Any references to “Architect” in the documentation should read “Performance Management 
Architect.” 

Accessing Hyperion Product Documentation 

The most recent version of each Hyperion product guide is available for download from the 
Documentation area of the Oracle Technical Network (OTN) Web site 
(http://www.oracle.com/technology/index.html).  

Documentation is also available from the Oracle E-Delivery Web site 
(http://edelivery.oracle.com/EPD/WelcomePage/get_form). Please note that individual product 
guides are available for download on the Oracle Technical Network (OTN) Web site only. 

Hyperion Planning Administrator’s Guide 

Chapter 2, Getting Started with Planning, Considerations for Working with 
Essbase 
• The topic should include this information on @XREF and HSP_NOLINK: 

The @XREF function looks up a data value from another database to calculate a value from 
the current database. You can add the HSP_NOLINK UDA to members to prevent the @XREF 
function from being added to different plan types. For more information on UDAs and 

http://www.oracle.com/technology/index.html
http://edelivery.oracle.com/EPD/WelcomePage/get_form
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functions, see the Hyperion Essbase – System 9 Database Administrator’s Guide or online 
help. 

Appendix D, Planning Application Migration, Step 1: Migrating Shared Services 
• As stated in the appendix introduction, the procedures apply only to "migrating applications 

from one environment to another (such as from Development to Production) for release 
9.3.1.”  

The instructions in step 2 say to “use the latest version of the Import/Export utility.” This 
step should also state, “If you are migrating while upgrading, you must use the 9.3.1 
version of cssImportExportUtility.” 

Hyperion Security Administration Guide 

Appendix F – Planning User Provisioning 
• In the section “Write Access to Essbase Data,” replace the reference “Analytic Services 

Write Access” role with “Essbase Write Access” role.  
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